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Getting Started
The IB Customer Activity Monitor (CAM) helps professional advisors and brokers quickly find and view all client activ-

ities, including the complete order history from initiation to execution, and its routing sequence. Our robust user interface

displays:

l Real-time Queries

l Audit Trails

l Account Status

This chapter includes the following topics:

l Downloading the Customer Activity Monitor

l Logging In

l CAM Menus

l CAM Menus

l Logging Out

Downloading the Customer Activity Monitor
To run the Customer Activity Monitor (CAM), you must first download it from IB’s web site and install it on your com-

puter.

To download and install the Customer Activity Monitor

1. Open IB’s web site in your web browser, then select Customer Activity Monitor from the Software menu.

The Customer Activity Monitor (CAM) page appears.
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2. On the Software tab, click the CAM Download button, then save the file to your computer.

3. Find the file you downloaded, then run it to install the CAM on your computer. The installation places the pro-

gram icon on your desktop.

Logging In

To log into the Customer Activity Monitor

1. Double-click the CAM icon on your desktop.

2. Enter your assigned user ID and password, then click Login.

CAM Menus
Use the Window, Account and Help menus to perform additional actions with the CAM screens.

Window Menu

The Window menu includes the following commands:

l Maximize all - enlarges all open sub-windows to their full size.

l Minimize all - shrinks all open sub-windows to small icons on the bottom of the main window.

l Cascade - arranges all maximized sub-windows in a cascading design that allows you to see their titles.

l Export - lets you save a text file of open orders or execution.

l Exit - closes the current version of CAM.

Account Menu

The Account menu includes the following commands:

l Account Status - opens the Account Window, which shows current account values and margin and trading limits

for the specified account.

Help Menu

The Help menu includes the following commands:

l About - shows the current version of the IB CAM.
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CAM Windows
The CAM is composed of the following windows:

l QUERYING BY USER NAME - This window appears when you search for a user name.

l QUERYING BY ACCOUNT - This window appears when you search for an account. It includes the tabbed win-

dows Query Open Orders and Executions, Search Audit Trail, and Track Order at Open Book.

l Account Window - This window shows details for the specified account. It is accessible from the Account menu.

If you have multiple accounts, the Account Summary window will appear as a separate window when you search for a

user name. The Query Open Orders and Executions, Search Audit Trail, and Track Order at Open Book tabs will appear

as tabs in a single window

The CAM also has several helpful features that are shared by all windows:

l Use the Group size field on the Query Open Orders and Executions, and Search Audit Trail windows to deter-

mine how many returned results are viewable at a time. The minimum group number is 10. If your search returns

more results than your group size, a Continue button becomes active to the right of the screen beneath the Find

button.

l Some of the tabbed titles of windows are blue, including Search Audit Trail, and the Open Orders and Executions

tabs. After you retrieve your search results, right-click a blue tab to display the results into a new stand-alone win-

dow.

l Many result lines and field titles allow you to drill down and select actions using the right-click menu. For exam-

ple, you can narrow returned results on the Open Orders and Executions screens by right-clicking a column head-

ing (i.e. Time, Action, Open Qty etc) and defining specific filter criteria, such as executions that occurred before a

certain time and day.

l You can resize each window that appears within the CAM by using the controls in the upper right corner of the

window. You can minimize, maximize and close each window using these controls.

Logging Out

To log out of the Customer Activity Monitor

1. From the Window menu, select Exit.
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Viewing Client Account Information
The IB Customer Activity Monitor (CAM) lets you view account information for any of your clients, including real-time

account balances, margin requirement and trading Limits, market value and portfolio.

This chapter includes the following topics:

l Account Summary Window

l Account Window

Account Summary Window
The Account Summary window displays basic registration and account information for a client account. For every

account associated with the account holder, the CAM displays the account ID, IB entity, when the account was opened,

the current status of the account, and whether or not the account is an IRA account.

The Account Summary window also includes three tabbed sections: Session Properties, Trading Permissions , and Market

Data Permissions.

The Personal Information section at the top of the Account Summary window provides the following information:

Field Description

User Name The account username.

Name The full name of the customer.

Customer Type ORG or Individual.
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Active Since The date the account was approved by compliance, in the format YYYY/MM/DD.

Address The address associated with the account.

Email The email address associated with the account.

Phone All phone numbers on file for the account of the account holder.

Account Summary Permissions

The Account Summary window three tabbed pages along the bottom of the window. The Session Properties page con-

tains information about the current TWS session and is for internal use only. The Trading Permissions page shows the

instruments that can be traded on specific exchanges, and the Market Data Permissions page shows the NYSE Open

Book and market data permissions for each exchange.

The following tables show all the information displayed on the Session Properties, Trading Permissions and Market Data

Permissions pages.
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Session Properties

Property Possible Values

IBCustomer ID The customer ID assigned by IB

IBEntity IBLLC-US, IBCA, IBEU

THGroupAffiliate Yes or No

THGroupAutoBooking

customerType 0,1

DefaultPage Yes or No

fa Yes or No

forceOATSDefaults Yes or No

gtcSupport Yes or No

IbClearingAccountNumber Uxxxxxxx - this is the U account number (F account number for ORG accounts.

maxmktdata 100 - This is the max allowable number of market data instances.

optionAcct USOPT/OPT/cfb/*/*/c

phylum prod

pooledAcct Yes or No

releaseSequence prod

residence USA/?

retailAccountType UNI.MULT - Universal or Cash account/ Multicurrency Permissions

retain_orders Yes or No

session_type TWS/

sizewndow Yes or No

sslStatus

useOrderStore Yes or No

usingmdf Yes or No - Uses the market data farm to receive data.

Trading Permissions

Column Name Description

Exchange Lists all exchanges available to the user for order routing

Instrument Type Shows valid instrument types for the corresponding exchange.

Firm Give-Up The clearing firm ID.

Give-up Ref IBCLRD/70224/8587/200 QT185/ 70224/1045/1501/*
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Market Data Permissions

Column Name Description

Exchange List the exchange acronym. Exchanges are listed multiple times if multiple security types

are supported.

Sec Type Lists all available securities types available to display market data on the corresponding

exchange.

Market Data Identifies whether or not customer has market data permissions for a specific instrument

on a specific exchange.

Deep Book Identifies whether or not the customer has permissions to view the Deep Book data for a

specific instrument on a specific exchange.

Account Window
The Account window in the Customer Activity Monitor is similar the Account window in Trader Workstation. It dis-

plays account balances, margin requirements and trading limits, market value and portfolio for the selected account or

account group.

To display the Account Window

1. Select an account from the Account ID dropdown, then from the Account menu, select Account Status.

2. If desired, in the Multiple Account Name section, select an account group.

3. To change the account, select a different account inthe Account ID dropdown, then select Account Status from

the Account menu. The Account window will update the displayed information accordingly.
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Balances

The Balances section shows the account balances for securities, commodities and in total. These balances don't include

margin requirements.

For complete descriptions of these fields, see the View Account Balances topic in the TWS Users' Guide.

Margin Requirements and Trading Limits

The Margin Requirements and Trading Limits shows the following information for the selected account:

l Current Initial Margin, Maintenance Margin, Available Funds and Excess Liquidity

l Overnight Initial Margin, Maintenance Margin, Available Funds and Excess Liquidity

l Day Trades Left - This is the number of day trades still available for a 4-day pattern day trader period. It does not

apply to futures.

For complete descriptions of margin requirement fields, see the Monitor Margin Requirements topic in the TWS Users'

Guide.

Market Value

The Market Value section shows you total value for the following items, sorted by currency:
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l Cash Balance

l Stocks

l Securities options

l Futures options

l Futures P&L

l Net Liquidation Value.

For complete descriptions of these fields, see the View Market Value topic in the TWS Users' Guide.

Portfolio

The Portfolio section shows the current value of each position. You can view zero position rows by selecting the View

Zero Position Rows check box.

For complete descriptions of the columns in this section, see the View Portfolio Value topic in the TWS Users' Guide.
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Querying Open Orders and Executions
Use the Query Open Orders and Executions window to view client activity for the current day.

This chapter includes the following topics:

l Query Open Orders/Executions Window

l Using Search Filters

l Viewing Open Orders

l Viewing Executions

l Exporting Open Orders and Executions

Query Open Orders/Executions Window
Use the Query Open Orders and Executions window to view client activity for the current day. This window appears in

the QUERYING BY ACCOUNT window when you search for an account ID.

The top section of the screen displays search fields you can use to find the accounts you want to view. The tabset in the

middle of the page lets you display Open Orders and Execution reports based on the search criteria you enter. The bot-

tom section displays the Audit History for the selected line on either the Open Orders or Executions page.

To open the Query Open Orders/Execution window

1. Select an account from the Account ID drop-down list, then click Find.

The QUERYING BY ACCOUNT window appears.
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Using Search Filters
Use the Search Filters to define search parameters for the client order(s) you want to view.
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Search Filters

Filter Description

Date/Time Select one of these options:

l All - displays all open orders

l Today - displays open orders transmitted today.

l Specify range - lets you set an ascending range of dates and times over

which to display results.

l Most recent - lets you set a descending range of dates and times over

which to display open orders.

l Streaming

Type Display results for a specific asset type. Select ALL to display results for all

asset types.

IB Order ID If known, you can enter an IB Order ID to see only those open orders asso-

ciated with this ID.

Exch ID If known, you can enter an Exchange ID to see only those open orders asso-

ciated with this ID.

Exec ID If known, enter the ID assigned to the executed order to view only that order.

Symbol Display results for a specific asset. If left blank, results will be returned for all

contracts.

Group size Determines how many returned results are viewable at a time. The minimum

group number is 10. If your search returns more results than your group size, a

Continue button becomes active to the right of the screen beneath the Find but-

ton.

Cust Order ID If known, you can enter a customer order ID to see only those open orders asso-

ciated with this ID.

Order Ref If known, you can enter an Order Reference number to see only those open

orders associated with this ID.

Viewing Open Orders

To view open orders

1. Select an account from the Account ID dropdown list, then click Find.

The QUERYING BY ACCOUNT window appears, with the Open Orders page displayed as shown below.
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Open Orders Information

The Open Orders page displays the following information:

Column Name Description

Time The date and time the order executed.

Action Identifies whether the contract was bought or sold.

Open Qty The order quantity that has not yet executed.

Underlying The underlying symbol.

Descr. The contract description.

Price The current market price per unit of the order.

Dest. The exchange to which the order was routed.

Status The status of the working order.

Cust Order ID A customer-assigned order ID.

IB Order ID An IB-assigned order ID.

Exchange ID An exchange-assigned ID for the order.

Order Ref A user-defined reference number.

Viewing Executions

To view executions

1. Select an account from the Account ID dropdown list, then click Find.

The QUERYING BY ACCOUNT window appears, with the Open Orders page displayed as shown below.

2. Click the Executions tab to display the Executions page.
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Executions Information

The Executions page displays the following information:

Column Name Description

Time The date and time the order executed.

Action Identifies whether the contract was bought or sold.

Qty The order quantity that has not yet executed.

Underlying The underlying symbol.

Descr. The contract description.

Price The current market price per unit of the order.

Dest. The exchange to which the order was routed.

Cust Order ID A customer-assigned order ID.

IB Order ID An IB-assigned order ID.

Exchange ID An exchange-assigned ID for the order.

Exec ID

Order Ref A user-defined reference number.

Totals

Contract The contract description.

Buy Total number of units bought.

Sell Total number of units sold.

Net (Number of units bought) - (number of units sold) = net units in

your portfolio.

Exporting Open Orders and Executions
The CAM lets you export a query if you need to gather data for order routing, execution statistics or tracking historical

activity. The following steps are specific to Excel, but you can export a query to any spreadsheet application.

To export a query to Excel

1. On the Window menu select Export.

2. In the Save As dialog box, select a path, enter a file name, and give the name a .xls extension so that Excel will

recognize the file type when you open it.

3. Open the file from Excel.

You may need to re-format the CAM information in the Excel file.
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Using Audit Trails
Use the Search CCP Audit Trail window to view all aspects of customer orders, from order initiation to order execution,

including any modified, cancelled and rejected orders. You can also use the Track Order at Central Book window to

view all aspects of a single order.

This chapter includes the following topics:

l Using the Search CCP Audit Trail Window

l Using the Track Order at Central Book Window

Using the Search CCP Audit Trail Window
Use the Search CCP Audit Trail to view all aspects of customer orders, from order initiation to order execution, including

any modified, cancelled and rejected orders.

l Use the Drilldown feature to see more details and order attributes on any search result. Click on an entry in the

Type field to see Audit History details for a specific ID.

l Click on the Order ID to track an order through the Central Book or view the CCP Audit Trail for a specific

order.

l Extract records for all types of transactions, including executions, cancels, submits, modifies, rejections fees and

sessions.

To use the Search CCP Audit Trail window

1. Select an account from the Account ID dropdown list, then click Find.

The QUERYING BY ACCOUNT window appears, with the Open Orders page displayed as shown below.

2. Click the Search CCP Audit Trail tab to display the audit trail search features.
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3. Select a day from the drop-down, either Today or a day up to five days past, or set a Date Range.

l Check the Most Recent check box to sort a date range in descending order from the most recent result.

4. Select an extraction type from the Extraction Type drop-down list:

l IB Order ID

l Customer Order ID

l Exchange ID

l Execution ID

l Order Memo

l Symbol

l Generic Text

5. Enter text representing the selected extraction type in the Extraction Key field. For example, if you chose IB

Order ID as the extraction type, enter a specific IB Order ID in the Extraction Key field. You can type part of

the entry and the system will find all orders with an extraction key containing the text you entered.

6. Select the type of entries on which you want to search from the Record Type drop-down list:
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l Orders

l Submits

l Executions

l Cancels

l Modifies

l Rejections

l Fees

7. Use the Group size field to determine how many returned results are viewable at a time. The minimum group

number is 10. If your search returns more results than your group size, a Continue button becomes active to the

right of the screen beneath the Find button.

8. Click Find. The results list appears in the Audit History box.

Using the Track Order at Central Book Window
Use the Track Order at Central Book window to view all aspects of a single order.

To track an order

1. Select an account from the Account ID dropdown list, then click Find.

The QUERYING BY ACCOUNT window appears, with the Open Orders page displayed as shown below.

2. Click the Track Order at Central Book tab to display the order tracking page.
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3. Select a day from the drop-down, either Today or a day up to five days past, or set a Date Range.

l Check the Most Recent check box to sort a date range in descending order from the most recent result.

4. Enter the IB Order ID in the IB Order ID field. An example of the required format is displayed on the screen for

you. You can find these numbers using the Search CCP Audit Trail window.

5. Enter the Central Book order processor in the Left hex code field. You can find these numbers using the Search

CCP Audit Trail window.

6. Use the Group size field to determine how many returned results are viewable at a time. The minimum group

number is 10. If your search returns more results than your group size, a Continue button becomes active to the

right of the screen beneath the Find button.

7. Click Find. The results list appears in the Audit History box.
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